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CFS (&VFT) to QuickBooks Interface 

For 

QuickBooks Premier & Enterprise Solutions 
Last edited: 3/8/2012 

 

Manual 
 

The purpose of this interface is to create an efficient and user 

friendly means for the transfer of jobs created in CFS to Estimates 

in QuickBooks where they can then be converted into Sales Order, 

Invoices, and/or Purchase Orders. 

 

This interface can be setup to track the on-hand inventory count in 

QuickBooks, or, to just track sales.  

 

During the transfer the user may choose a QB “group” mode. In this 

mode the items will still be listed individually on the screen display 

in QB but print as a group or groups using the job description as the 

group name. (Group is a QB option and is limited to 20 items per group so there could 
be more than one group on the output. See QB for more detail.) 

 

The CFS to QuickBooks Interface is built upon the CFS Enterprise 

Edition tools so QB Interface customers are automatically CFS 

Enterprise customers and receive all the Enterprise features. 

This initial interface release will not work with QB for Canada, QB POS, or QB Online. It will not work with QB 
Pro as Pro does not accommodate for assemblies. This could change if our market dictates such. 

 
CFS to QB Interface   Ask for direct number to QB interface support only  
Project Manager   800-544-2536 toll free 
Software Design Associates  406-256-5133 fax 
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CFS & QuickBooks Interface 

Preparation 
 

CFS Setup Requirements 
 

Sales Tax 
The Sales Tax templates in CFS should be setup to replicate the Sales Tax options in QB. The 
interface is going to ignore the sales tax associated with a job coming from CFS because QB will 
be handling the application of the correct tax. The reason to have the sales taxes replicated in 
CFS is so the bottom line price of the job includes applicable sales taxes the same as how it will 
appear in QB after the job is exported. 
 

Labor Records (Step not necessary if not planning to track inventory.) 
Add the word “Labor” to all labor type items in CFS that may be a component of an assembly or 
a CFS fabricated item such as fabricated chainlink gates and posts and fabricated PVC and 
ornamental products. The program is NOT case sensitive. The easiest way would be to add the 
word Labor to all labor type records like Cuts and Welds and lumber cutting charges. If you 
fabricate PVC or ornamental fence you probably have fabrication charges that should contain the 
word Labor. It does not hurt anything to have the word Labor in a labor item that is not going to 
be used as a component of an assembly so by adding it to all labor type records, whether they 
will be components or not, you know you have covered all current and possible future situations 
where it might be needed. Using the Update tool “Change Descriptions” is probably the quickest 
way to do this. 
 
If you have the CFS Enterprise Edition and export the master file to a spreadsheet program like 
Microsoft Excel to do your updates, make sure you add the word “Labor” to the Description field 
as the entries in the Item field do not import back into CFS. 
 

Unit of Measure 
 
If you turn on the U/M option in QB, (see QB setup instructions), the U/M on CFS transactions 
will display on QB transactions. QB only recognizes two characters for the U/M so if the unit in 
CFS is more than two characters it will use the first two and truncate the rest.  You may want to 
make sure the unit designations in CFS are limited to just two characters and consistent 
throughout the master file so you can get the results you want- for example Bg instead of Ba if a 
unit is currently Bag. You can use “Change Descriptions” to update these fairly quickly. If you 
have already purchased the QB Interface or otherwise have the CFS Enterprise Edition you could 
export the file with InterOp, update the Units, and bring it back into CFS. The ability to update 
the Unit in InterOp was added to the 2.50 version of InterOp in late March of 2011 so you may 
need to ask for a more current version if you take this route. The version number is in the lower 
right hand corner of the main InterOp window. 
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Check for unnecessary assembly related flags 
 
The flags "U", "A", and "E" [for (U)n-assemble to components for inventory tracking, weighted 
(A)verage so the program auto figures the markup on the assembly based on the markups on the 
component parts, and (E)xplode so the components list individually on the output] should only 
be in items that are setup as assemblies in CFS. The culprit here is an unnecessary U flag that can 
cause jobs not to transfer to QB. 
 
To check that your data does not have this problem, go to the Update Master File>Maintenance 
menu and near the bottom choose "Check Master File & Save Files for common errors". Have 
"Print Report" selected at the bottom of the window. See the section on unnecessary flags. Click 
"Check" and view the report - if there is any to report. Resolve the problem by removing the 
flags from the items, deleting the items from the Master File, or creating the assembly. 
 
If you create an assembly but are setup to have all your items in QB as non-inventory parts there 
is a follow-up step you'll need to do so it imports into QB properly. Assemblies serve two 
purposes. One to track the inventory of the component parts, and two, to let the program 
calculate the cost of the assembly by auto totally the cost of the component parts for the cost of 
the assembly. Even though you are not doing the former you may be interested in the latter. 
 

Optional import of QB customers into the CFS customer file 
 

If you have some customers in QB, maybe some repeat customers, that you would like to import 
into CFS, there is a semi-automatic way of doing this. You would need to have the interface 
installed before having access to this function. The interface program to export customers will 
export the QB customer list into a format that CFS can recognize. 
 
The exported file will be named customer.csv. It needs to be renamed to SDA_CUSTOMER.csv 
and put in the main CFS folder. CFS will read this file from the “Customer Information” 
window. You will have an option to open the list and when you choose a customer, this feature 
imports the information from the file into the appropriate fields in CFS. Once the information is 
loaded you still need to save it in the CFS customer file if you want it saved within CFS. 
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CFS & QuickBooks Part Number Setup 
 
There are many ways to setup the interface for tracking or not tracking inventory on hand. 

Setting up the proper scenario for you is part of the provided interface setup routine so you 

do not need to do this by yourself. Once you decide which option suites your needs you can 

skip to the common information and that options detailed setup directions. If scenario 1 or 

2 is your preference but you want to temporarily use the interface in a non-inventory 

tracking mode until you can get accurate inventory counts entered in QB, you should also 

accommodate for scenario 4 or 5 to use in the mean time.  

 

1. Track inventory on hand in QuickBooks. Only sold jobs will be sent to QuickBooks. 

 

2. Track inventory on hand in QuickBooks. Intend to “borrow” the Estimate mode of 

QB for un-sold jobs. 

 

3. Do not track inventory on hand in QuickBooks. Sales related to individual items will 

be tracked. 

 

4. Do not track inventory on hand in QuickBooks. Number of items in QB is limited – 

items do not need to be listed individually. All sales recorded to the same sales 

account. 

 

5. Do not track inventory on hand in QuickBooks. Number of items in QB is limited – 

items do not need to be listed individually. Sales to be recorded to more than one 

sales account.  

 

Common Information 

 

All items in CFS including labor items must have a part number in their part number field with 
one exception – see below. This can be done using tools within CFS Update Master File> 
Change Utilities or with the InterOp utility available with the CFS Enterprise Edition. InterOp 
can be used to export the master file to a spreadsheet program such as Microsoft Excel where the 
part numbers can be entered and then imported back into CFS. The exception is that any 
assemblies in CFS where the assembly item contains an E flag in order to have the component 
parts automatically be on the list of materials, does not need to have a part number. The 
component parts all need part numbers but the (E) assembly itself does not. 
 

Part Numbers must NOT include spaces. Dashes can be used as separators. They also need 

to NOT start with a “P” or a “G” as entering a “P” initiates a post fabrication routing and 

“G” initiates a gate fabrication routine. 

 

The part numbers of “CUSTOM”, “FABRICATED”, “FAB-POST”, “FAB-PIECE”, and 

“SECTION” have special meanings in the interface export so do not use these names for a 

part number in the CFS records. 
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Special consideration when the source number is longer than twelve characters: 

If the word “SOURCE” is in the part number field, CFS will put the Source number in the part 
number field of the XML export file. It will also use the source number on reports within CFS. 
When it comes to products only purchased from one vendor, which is often the case with PVC, 
ornamental, and wire panel fencing, people usually use the vendor’s part number (the Source 
number in CFS) as the primary, common number in CFS and QuickBooks. As mentioned above 
this means the source number would need to be moved or copied into the part number field in 
CFS. While the source number field can be expanded from a twelve character to a fifteen 
character maximum length, the part number field cannot. Some vendors’ part numbers are longer 
than twelve so would get truncated if copied into the part number field. To resolve this issue you 
can put the word “SOURCE” in the part number field. You will basically be “telling” CFS you 
want to use the source number for the part number. If you run into this situation, you need to put 
“SOURCE” in the part number field for at least these items. This will work whether the vendor’s 
number is longer than 12 characters or not, so you can setup all the items for the vendor this way 
if you like. You could also do this for all items in your Master File where you want to use the 
source number as the part number for the interface. Call support if you would like to know if you 
should expect this situation for any of the vendor specific modules in your Master File. The 
program is not case sensitive to the word “SOURCE” so you can use “Source” if you like. 
 

CFS Write-In Entries 

To accommodate for the situation where in CFS you can estimate or sell an item that is not in the 
CFS item list, what is referred to as a Write-in Entry, CFS assigns a part number of CUSTOM. 
When items are brought into QB, the same item cannot be listed on the same transaction more 
than once. If the interface runs into this situation it appends the part number with a number. If 
there are more than one Write-in entries on a CFS transaction that gets transferred to QB these 
items’ part numbers would be CUSTOM, CUSTOM 1, CUSTOM 2, etc. It is best to have these 
items setup in QB during the initial setup to avoid a situation where if a CUSTOM item gets 
added on-the-fly on a job with a discount the price may be off. If the item is already in QB at the 
time of transfer, this potential problem can be avoided. There is an import file available for 
adding a dozen of these non-inventory items to QB or they could be entered manually. These 
items get reused on subsequent jobs so there only needs to be enough to accommodate the 
maximum number that would ever be on one transaction. 
 
 

1-Detailed Track inventory on hand in QuickBooks. Only sold jobs will be sent to 

QuickBooks. 

 
The common information above is relevant to this situation. 
 

2-Detailed Track inventory on hand in QuickBooks. Intend to “borrow” the Estimate 

mode of QB for un-sold jobs. 

 
The common information above is applicable plus more. If you want to send un-sold jobs to QB 
to make use of some QB Estimate or other QB options, it is important to avoid the automatic 
building of assemblies in QB which happens during the job transfer if it is in the inventory 
tracking mode. When exporting an un-sold job, un-check the “Detailed Inventory Tracking 
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Mode” box. The program will automatically treat all items like Write-in entries and assign a part 
number of “CUSTOM”, but this part number will be appended depending on which module you 
are working in: 
 
Chainlink Scratch Builder   CUSTOM-S, CUSTOM-S 1, …CUSTOM-S 30 
Residential chainlink Scratch Builder  CUSTOM-R, CUSTOM-R 1, …CUSTOM-R 20 
PVC Scratch Builder    CUSTOM-P, CUSTOM-P 1, …CUSTOM-P 12 
Ornamental Scratch Builder   CUSTOM-O, CUSTOM-O 1 ,…CUSTOM-O 12 
Wood Scratch Builder    CUSTOM-W, CUSTOM-W 1, …CUSTOM-W 12 
Wire Panel Scratch Builder   CUSTOM-X, CUSTOM-X 1, …CUSTOM-X 12 
Miscellaneous Estimator   CUSTOM-E, CUSTOM-E 1, …CUSTOM-E 20 
Cash Register     CUSTOM-C, CUSTOM-C 1, …CUSTOM-C 20 
 
These item names are incremented to an estimate of how many would ever be likely to be on the 
same transaction. You could have less or more. Component parts of any permanent or re-usable 
assemblies will be ignored. These items need to be put in QB manually or with the QB Excel 

import utility prior to job imports. We have a file of these items ready to be modified and 

imported during the setup process. You would most likely assign the same sales account to all 
of these custom items, since this sales account will never get used anyway. These items should 
be non-inventory items. 
 
The QB estimates created in this mode would not be converted to a sales order or invoice in 
QB as inventory would not be tracked. Instead, if the customer subsequently accepts the bid, 
load the job in CFS and transfer again but in the inventory tracking mode. 
 

3.-Detailed Do not track inventory on hand in QuickBooks. Sales related to individual 

items will be tracked. 

 

With this approach have the check mark in the box next to “Detailed Inventory Tracking 
Mode”. Each item would have its individual part number as described in the common 
information. The basic difference is the items would be in QB as non-inventory parts. The 
permanent and reusable assemblies/fabricated items need to be in QB as non-inventory parts 
instead of assemblies. 
 
Any permanent assemblies would be exported or manually entered into QB as non-inventory 
parts with the appropriate sales account. Where assemblies are normally excluded from the mass 
transfer of items to QB, in this case they would be included and transferred along with the other 
items as non-inventory parts. They could also be entered in miscellaneous estimator and exported 
as non-inventory items. 
 
In order to have all the possibilities of fabricated  parts coming from CFS to be recorded as non-
inventory items in QB you need to have the following items in QB as non-inventory items 
before estimates are transferred. These items are available in a file for uploading and should be 
added to QB during the setup process. 
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Keep in mind you only need to add the items that are relevant to the product lines you estimate 
in CFS. For example, if you do not fabricate PVC or ornamental fencing you do not need to add 
the associated items below, FAB-PIECE-P, FAB-PIECE-O, SECTION-P, SECTION-O to QB. 
 
For fabricated Chainlink Scratch Builder gates: 

FABRICATED, FABRICATED 1, FABRICATED 2, ….FABRICATED 10  
For fabricated Chainlink Scratch Builder posts: 

FAB-POST, FAB-POST 1, FAB-POST 2, ….FAB-POST 10 

For PVC and ornamental fabricator module fabricated individual post, rails, and pickets: 
FAB-PIECE-P, FAB-PIECE-P 1, FAB-PIECE-P 2, ....FAB-PIECE-P 10, 

FAB-PIECE-O, FAB-PIECE-O 1, FAB-PIECE-O 2, ....FAB-PIECE-O 10 
PVC, ornamental, and wood fabricator module fabricated whole sections will be: 

SECTION-P, SECTION-P 1, SECTION-P 2, ….SECTION-P 10, 

SECTION-O, SECTION-O 1, SECTION-O 2, ….SECTION-O 10, 

SECTION-W, SECTION-W 1, SECTION-W 2, ….SECTION-W 10 

 
When the fabricated items are in QB as non-inventory items the component parts are ignored 
which is appropriate if you are not tracking what is in stock anyway. Also, contrary to when 
these items are in QB as reusable assemblies and the interface does not reuse them when they are 
on a sales order, it will reuse them even if they are on a sales order if they are in QB as non-
inventory items. This is also appropriate. 
 
The Write-in entry items based on the word CUSTOM should be imported into QB during the 
setup process as mentioned in the common information. 
 

4.-Detailed Do not track inventory on hand in QuickBooks. Number of items in QB is 

limited – items do not need to be listed individually. All sales recorded to the same sales 

account. 

 
In this situation there is no need for part numbers in the CFS items. The only thing in the 
common information pertinent here is the need for the CUSTOM items for Write-in entries. With 
this approach do not have the check mark in the box next to “Detailed Inventory Tracking 
Mode”. The program will automatically treat all items like Write-in entries and will assign a part 
number of “CUSTOM” but this part number will be appended depending on which module you 
are working in. To only record to one sales account use the same account for all the groups of 
items. An Excel or csv file of these items is available for importing them into QB. 
 
Chainlink Scratch Builder   CUSTOM-S, CUSTOM-S 1, …CUSTOM-S 30 
Residential chainlink Scratch Builder  CUSTOM-R, CUSTOM-R 1, …CUSTOM-R 20 
PVC Scratch Builder    CUSTOM-P, CUSTOM-P 1, …CUSTOM-P 12 
Ornamental Scratch Builder   CUSTOM-O, CUSTOM-O 1 ,…CUSTOM-O 12 
Wood Scratch Builder    CUSTOM-W, CUSTOM-W 1, …CUSTOM-W 12 
Wire Panel Scratch Builder   CUSTOM-X, CUSTOM-X 1, …CUSTOM-X 12 
Miscellaneous Estimator   CUSTOM-E, CUSTOM-E 1, …CUSTOM-E 20 
Cash Register     CUSTOM-C, CUSTOM-C 1, …CUSTOM-C 20 
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These custom items need to be put in QB manually or with the QB Excel import utility 

prior to job imports. We have a file of these items ready to be modified and imported. You 
would assign the appropriate sales accounts and make them non-inventory items. Something to 
note is that the same item sold through different modules may be recorded into different sales 
accounts.  
 
Component parts of any permanent or re-usable assemblies will be ignored. 
 

5.-Detailed Do not track inventory on hand in QuickBooks. Number of items in QB is 

limited – items do not need to be listed individually. Sales to be recorded to more than one 

sales account.  

 
With this approach do not have the check mark in the box next to “Detailed Inventory Tracking 
Mode”. There is no need to have part numbers in the CFS items. 
 
 What happens in this setup is each CFS item will include an entry designating a type of fence. 
The program will use the first character of this designator as the extension on the base word 
“CUSTOM”. These custom items will be imported into QuickBooks as non-inventory items and 
with an appropriate sales account associated with each group. It is recommended to use the same 
fence type designator that the program would automatically use per step 4 unless there is a 
compelling reason to set it up differently. 
 
 To associate the designator to the items in CFS: 

1. Set pointer 20 to “1”. 
a. To do this go to Update Master File, Settings tab, choose Change Pointer Settings, 

Pointer.0, a single pointer, 20, and set it to “1” and click next and then close out. 
2. Determine in advance which groups of items in the CFS Master File will be designated to 

the same fence type and subsequently to the same sales account in QB. 
a. One way to do this is to go to Update Master File, Open Record, browse through 

the items and make notes of the various boundary record numbers. 
b. Another way is to print the Master File to a pdf and browse the printouts for the 

boundary record numbers. 
3. Go to Update Master File and type “INTERNAL” and enter. This is not a menu choice 

but you should see it show up near the bottom of the window when you type it. 
a. On the Internal Special Functions menu choose “LOW LEVEL change”. 
b. Enter a beginning and ending record number for a group of records as noted in 

step 2 and click OK. 
c. At the question “Which MF$()/MFN() subscript to change?” type “22” and enter 

or click OK.. 
d. At the “Enter MFS$(22)=” type the fence type designator and press Enter or click 

OK. 
e. Click Yes when prompted “Are you sure?” 
f. Repeat for each group of records making sure that all items in the master file have 

a fence type designator. 
g. The following are the default fence type designators. It is recommended you use 

these same codes unless you have a specific need to use something else. 
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i. Chainlink  S Resulting part number will be CUSTOM-S 
ii. PVC   P Resulting part number will be CUSTOM-P 

iii. Ornamental O Resulting part number will be CUSTOM-O 
iv. Wood  W  Resulting part number will be CUSTOM-W 
v. Wire Panel X Resulting part number will be CUSTOM-X 

h. Items with these part numbers should be added to the QB item list during the 
setup of the interface. There is an import file in Excel and csv format available for 
quick import. 

i. The regular Write-in entry items with part numbers base on CUSTOM but with 
no fence type identifier need to be added to QB during the setup as mentioned in 
the common information.  
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QB setup Requirements & Options 
 

Tracking Inventory 
If you plan to track inventory make sure you have this option turned on in QB. 

 

Unit of Measure 
The Unit will import from CFS. If you would like the Unit to display in QB the Unit of Measure 
needs to be turned on. In QB 2010 (and maybe other versions) go to Edit> Preferences> Items & 
Inventory> Company preferences> Enable Unit of Measure> choose Single unless you need it 
set to Multiple. Make sure the unit designations in CFS are consistent throughout the master file. 
See CFS setup requirements for more information about this issue. 
 

Customize the Estimate form in QB 
Make sure your QB is setup so you can create estimates. You can take advantage of some 
functionality if you make sure your estimate form in QB is setup to include the Sales Rep field as 
the sales rep can be imported on its way out of CFS and populate this field.  
 
If you have the Ship To address block on your QB estimate, this information will also import 
from CFS if it is in the CFS job information.  
 

Chart of Accounts and Required Items 
1.  Verify that the Chart of Accounts meets your needs: 

(a) There has to be at least one income account, COGS account, and Inventory 
account. You may choose to have sub accounts in each of these types. 

(b)  Several other income accounts are recommended 
(i) “Contra Income” for recording discounts. 

(ii)  “Freight” for recording freight charged for deliveries to customers. 
(iii) “Labor sales” or “Installation Labor” 

 
2.  Some Items are required to be in the Item List whether you plan to track inventory on 

hand or not. They need to have these exact names. The description of each may be 
whatever you like. 

(a)  Freight (Type is Service) 

(b)  Discount (Type is Discount) 
(c)  Labor (Type is Service) 

(d)  Some non-inventory parts and maybe other items depending on which inventory 
tracking or non-tracking option is setup as described in the previous chapter.  

 
3.  Note: QuickBooks does not allow the creation of Non-inventory Parts with the same 

part name/number as an Inventory Part that has been made inactive. 
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Installation 
 
A Software Design Associates support person will assist in the installation and setup of the 
interface. The following is a checklist of the setup requirements that need to be dealt with. 
 

1. Backup the CFS and QuickBooks data. The data to backup in CFS is the MASTER.0 
file and all the files beginning with the word SAVE. Make sure you are doing this in your 
main CFS installation on your server if you are in a network environment. 
 

2. Make sure the CFS program files are current. To do this go to the CFS Utility 
window, Online Support, Online Services, and click “Check for Updates Now”. 

 

3. The interface program files should be installed onto the local drive of each computer 

where the interface is needed. 

a.  We recommend you have a folder named “Apps” in your local CFS folder. Inside 
the Apps folder will be sub-folders for each of the CFS Enterprise apps that would 
be appropriate for running locally. The only one that needs to run locally is the 
QB Interface app. So the Apps folder would contain at least a folder named 
“QB_Interface”.  

b. The usual path would end up being C:\CFS\Apps\QB_Interface. 
c. The drive letter can be something different from C and the CFS folder and Apps 

folder could have different names but the QB_Interface folder must be named 
this. 

 

4. Make sure you know where the QuickBooks company file is stored. You can look 

this up by opening QuickBooks to the appropriate company and pressing the F2 

key. 

 

5. To install in Windows XP: 

 
a. Have QuickBooks open as an administrator and in the single user mode. 

b. Unzip the attached Setup.zip to a folder on your computer. 

c. In the folder where you unzipped the archive, run the Setup.exe file. 

d. Towards the end of the installation have it automatically start the application. 
Browse to locate the QB company file and then click Test Connection. Follow the 
on-screen instructions. When registering the interface to access QB choose to 
allow access even when QB is not open. It is recommended to have QB open 
when exporting jobs to it but this way you will not be restricted if you needed to 
export when it was not open. 

e. If CFS is running over a network and you are dealing with the Enterprise version 
of QB, when browsing to the CFS folder, go to My Network Places, or Network 
to locate the main CFS folder. Do not browse through a mapped network drive. 
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6. For Vista and Windows 7 installation: 

a. Close QuickBooks (Applicable for secondary setups also.) 

b. Right-click on the installer (Setup.exe) and choose “Run as administrator”  

c. Install the program but uncheck to start the application. Finish and then double 
click the CPANEL.exe and browse to find the QB company file. Click test 
connection and yes.  

d. When doing the subscription from the application, open QuickBooks by right-
clicking on the icon and selecting “Run as administrator”. After it is open make 
sure it is in the single user mode. 

e. Allow access of the application to the QuickBooks file  

f. Close QuickBooks. In the future, you don’t need to open QuickBooks as an 
administrator. 

g. If CFS is running over a network, when browsing to the CFS folder, go to My 
Network Places, or Network to locate the main CFS folder. Do not browse 
through a mapped network drive. 

  

To uninstall the interface: 

- Go to Start > Settings > Control Panel > select Fence Software QuickBooks Application and 
press Remove 
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Setup checklist 
 

1.  Interface programs installed in the local CFS> Apps> QB_Interface folder.  
(a) The CFS and Apps folder may be named something else but the folder the 

interface is installed in must be named “QB_Interface”. Interface files are: 
(i) CPANEL.exe 
(ii) CFSSetupMaintenance.exe 
(iii) ExportCustomer.exe 
(iv)  ImportEstimate.exe 
(v) AccXmlWrapper.exe 
(vi) Customer.csv 

(1) ExportCustomer will export the QB customers to create this file 
(vii) Sales_Reps.csv 

(1) This file is created by the user. It contains only two fields, the sales rep’s 
initials and the sales rep’s name. Create a csv file that only contains the 
initials and the person’s name. Save it with the name Sales_reps.csv and 
save it in the QB_Interface folder. 

(i) You type this into any word processing program and Save As with the file 
type set to a csv file. If you type it in Notepad it will automatically be a 
.txt file of which you can just rename with a .csv extension. 

(viii) Last_invoice.log 
(1) This file is created by AccXmlWrapper and stores the last invoice number 

transferred from CFS. The program reads this file to possibly generate a 
warning dialog box that an invoice has been transferred to QB previously. 

(ix) csvReFormatApp.exe  
(1) In order to import an Excel file of products intended to be imported into 

QB that has been saved in the csv format, this file needs to be reformatted 
a certain way. You can reformat it by running this reformatting app on the 
file. You can also drag and drop the file on this app and it will create the 
reformatted file. If you want to view it after reformatting, do not open the 
file in Excel again as this will reverse the reformatting. Instead, right click 
it and open with Notepad.  

 
2.  The control panel needs to be setup appropriately with the CFS location being the 

main CFS folder for sharing data if on a network. 
 

3.  The enterprise.xml file should be in the local CFS folder and configured 
appropriately. It needs a line independent of a settings group similar to the following 
example. This path is user defined but a folder named “QB_Interface” has to be at the 
destination of where this path points to. The following is a typical enterprise.xml 
configuration. Notice the last line that defines the location of the QB_Interface folder. 

 
(a) Note: The Apps can be in whatever order you prefer on the menu. If you do not 

intend to use an App you do not need to include that <settings> group. 
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<settings> 
<xmlfilepath>C:\CFS\Apps\XML_Reader_App\XMLReader.xml</xmlfilepath> 
<xmlexecpath>C:\CFS\Apps\XML_Reader_App\cfs-xml.exe</xmlexecpath> 
<sda_menu_name>Export to XML & View with XML Reader App</sda_menu_name> 
<sda_icon_name></sda_icon_name> 
</settings> 
<settings> 
<xmlfilepath>C:\CFS\Apps\Inventory_Analyzer_App\InventoryAnalyzer.xml</xmlfilepath> 
<xmlexecpath>C:\CFS\Apps\Inventory_Analyzer_App\InventoryAnalyzerApp.exe</xmlexecpath> 
<sda_menu_name>Export to XML & Run Inventory Analyzer App</sda_menu_name> 
<sda_icon_name></sda_icon_name> 
</settings> 
<settings> 
<xmlfilepath>C:\CFS\Apps\Commission_Assistant_App\CommissionAssist.xml</xmlfilepath> 
<xmlexecpath>C:\CFS\Apps\Commission_Assistant_App\CommissionApp.exe</xmlexecpath> 
<sda_menu_name>Export to XML & Run Commission Assistant App</sda_menu_name> 
<sda_icon_name></sda_icon_name> 
</settings> 
<settings> 
<xmlfilepath>C:\CFS\Apps\QB_Interface\Export.xml</xmlfilepath> 
<xmlexecpath>C:\CFS\Apps\QB_Interface\AccXMLWrapper.exe</xmlexecpath> 
<sda_menu_name>Export to QuickBooks</sda_menu_name> 
<sda_icon_name>C:\CFS\Apps\QB_Interface</sda_icon_name> 
</settings> 
<qbpath>C:\CFS\Apps\</qbpath> 

 
4.  If CFS is on a server there needs to be a CFSSetup.dat in the server CFS folder. This 

file is in addition to the normal CFSSetup.dat in the local CFS folder. 
 

5.  InterOp.exe needs to be located in the main CFS data folder. 
 

6.  If the intent is to track inventory on hand in QB, an APF.txt file needs to be in the 
main CFS data folder. This file is created by running the APF.exe file which exports 
the assemblies (a.k.a. additional pricing functions) out of CFS into this text file. 
When running InterOp for the purposes of populating the item list in QB (which is 
what the Setup & Maintenance option does) it is important to exclude the assembly 
items in CFS. By having the APF.txt present in the same location as the CFS master 
file, InterOp will exclude them when creating the export file. This is also true when 
running InterOp directly. 

 
7.  After the installation is complete and the commonly sold items have been imported 

into QuickBooks, go into Update Master File in CFS and force the recreation of the 
cross reference table for the Record, Source, Part number fields. This can be done by 
selecting Import another master file, then closing that window, and quitting Update. 
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Daily Activity 
The interface is flexible and powerful so it is important to understand your 

options. This flowchart covers inventory tracking options. The second 

flowchart focuses on the workflow. 
 

 
 

Recommendation: Convert estimates of sold jobs to an invoice in CFS in order to “borrow” the 
CFS invoice automatic numbering system to use as a reference back to CFS once the job has 
been transferred to QB. It will show up in the QB memo field. Also, this will be an identifier that 
the job is sold and not still an estimate. (Optional: if the sale and delivery of material is 
immediate, give the customer the CFS invoice and export to QB later.) 

When exporting from CFS (or VFT) 
(Inventory tracking or no inventory tracking) 

Interface makes use of reusable non-inventory 
items in QB with a name/number of CUSTOM, 
CUSTOM 1, CUSTOM 2, etc. when creating the 
QB estimate. Components of assemblies and 
fabricated items are ignored. 
 

All items are tracked for 
inventory purposes. Any 
assemblies and/or program 
fabricated parts will be built 

in QB.  

QB estimate 

may be 

converted to 

sales order or 

invoice. 

User would ONLY convert 
this QB estimate to a sales 
order or invoice if he or she 
does not want the items 
added to QB as permanent 
items. 

Usually track 

inventory 

When this job is imported 

into QB it would 

immediately be converted 

into a sales order or invoice, 

whichever is appropriate. 

Inventory tracking mode (off)  
For those who do not intend to track inventory at all.  
And for those that do want to track inventory, this 
mode is for un-sold jobs or jobs where all items are 
to be non-inventory items and you do not want them 
added to the QB item list permanently. 

Inventory tracking mode (on) 
For those that want to track the 
inventory of this job AND the job 
is SOLD. 
 

Never track 

inventory  
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Workflow 
 

 

1. User initiates job export from CFS in either 

inventory tracking or non-tracking mode. 

2. Window pops up for user to make choices. 
a. Option to enter reference to job in CFS. This field 
would auto fill in with invoice number if there is one 
or UNSET if not. The user can change the ref and it 
would show up in Memo field in QB. 
b. User chooses from a list of customers already in 
QB or enters a new customer name/number that will 
then be added to the list in QB. 
c. User has option to choose a sales rep. 
d. User will have option to have the items go over as 
a Group in QB in order to have the subsequent 
option in QB to print the transaction with a one line 
description of the job rather than as an itemized list. 
 

User clicks button to initiate transfer. 

3a2. Job imports into QB and Estimate opens automatically if QB is running.  
Customer code, name & address, memo, & sales rep fields are filled in from 
earlier choices. User fills in more fields if desired. All sales taxes are dealt with 

solely by QB. Sold jobs should be immediately turned into Sales Orders. Save & 

done. 

3a1. Items not in QB are detected. For each 
new item a window pops up with a Description 
and you can change the default accounts if 
necessary - Income, Asset, COGS accounts,  
and Item type. If defaults are not appropriate 
you can also cancel, go to the Control Panel, 

change the defaults, then start the export again. 



  Page 18 of 35 

 

Daily Use Explanation 
 

Customer name is required 
There has to be a customer name associated with the job before it is exported. (You will get 
notified if there is not.) You have the option to transfer under any name and then associate the 
job with the correct customer/job after it is in QuickBooks. If you have entered customer 
information that will be new to QuickBooks, QB will use its Quick-add feature to add the new 
name in its customer center when the job is imported. This is convenient because you do not 
have to first put the customer in QB before sending the job over. The drawback, which I will tell 
you how to overcome, is that while the address transfers into the address block on the transaction 
in QuickBooks, the Quick-add feature only saves the customer name in the customer information 
in the Customer Center.  
 
Tip:  When you know the customer is going to be new to QuickBooks, or, you know you want to 
update the address in QuickBooks, you can intentionally have at least one incorrect character on 
the street/mailing address line in CFS so that after it transfers you will have something to change. 
You could put an X at the end. After the job is transferred to QuickBooks, remove the X from 
the address block. QuickBooks will prompt if you want to update the customer file. If you click 
“Yes” it will add the entire corrected address to the customer file. Warning: Do not put the 
incorrect character(s) in the name because QuickBooks will add a new customer instead of just 
correcting the old one. 
 

Sold Jobs versus Estimates 
Jobs that are sold, either as sales orders or needing to be invoiced immediately, need to be 
exported differently from jobs that are still just estimates at the time of the export if you intend to 
track inventory with this interface. 
 

Exporting Sold Jobs (When you do want to track inventory) 
 
Jobs can be exported from any of the Scratch Builder reports menus, the Miscellaneous 
Estimator reports menu, and the Cash Register reports menu. If the job be converted into an 
invoice in CFS first and then exported, the invoice number will show up in the memo field in QB 
for a reference back to CFS. Once the job is in QB, immediately convert it into a Sales Order or 
Invoice. Here is a sample CFS job that has been converted to an invoice before exporting. The 
word “Invoice” can be changed to a different word, like “Job”, if you like. 
 
If you transfer CFS estimates directly from the estimating modules you could use the job 
numbering system and use the job number as your QuickBooks memo reference back to CFS. 
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Next you would choose “Export to QuickBooks” on the Export window. 
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If needed, open the drop down window to choose a pre-existing QB customer. 
 

                                  
 
When you click the Export to QuickBooks button, and there are no items new to QB, the QB 
estimate is created and will automatically open up if QB is running. New customers are added 
with “Quick add”. 
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.  
Sold jobs should be immediately turned into either a sales order or invoice for best results. 

 

The “Group” option 
 
The group option is included so you will have a choice later to print reports in a summary 
format. Keep in mind QB groups are limited to 20 items or less so you could end up with more 
than one summarized group on a report. The following is an example of an invoice printed when 
the group option had been chosen. 
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QuickBooks will not include the tax in the summary number. Also, if there had been a discount 
printed separately it will be on a separate line here. If you do not want the discount to list 
separately, choose the appropriate option when applying the discount in CFS. 
 
Note: Descriptions can be up to 4095 characters in QB. The top message line can be longer than 
4095 but would get truncated coming into QB. 
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When job items are new to QuickBooks 
 
If one or more of the items in the CFS job are not already in QB an intermediary window will 
pop up for you to confirm or change the accounts to be associated with the items when the 
interface adds them to the QB item list. 
 

 
 

Note: New items to QB are imported on the main level in QB. If you want them to be a 

“Sub of” item you will need to do that within QB. 

 

If these default accounts for this particular job are not correct, you can change them here, or, you 
can cancel the export, go to the Control Panel…… 

 
 
….change the default accounts, Save, and initiate the export again. 
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If the job being exported is not sold yet - an estimate 
 
On the export window you can turn off the inventory tracking by un-checking the tracking 
option, which you should do in order to prevent QB from creating and building assemblies for 
fabricated products that you don't know if you are going to sell or not. 
 
After exporting, the estimate in QB will show each entry as having an appended part number of 
CUSTOM-[], CUSTOM-[] 1, CUSTOM-[] 2, etc. These part numbers do not need to show on 
the estimate that customers see if you don't want them to. Everything else will look just like the 
list of items on a report in CFS along with the same selling prices and you can print, email, etc. 
just like you do now. 

 
  
If the customer orders the job, you will go back to CFS and load it there. This time you will have 
it in the inventory tracking mode. (The items will retain their appropriate part numbers or list as a 
fabricated product.) (Assemblies and fabricated products will be tracked in QB as assemblies for 
proper inventory tracking.) After it is in QB you would immediately turn it into a Sales Order or 
Invoice. A Sales Order would be turned into an Invoice whenever appropriate. 
  

Summary: 

If you do not intend to track inventory on hand, see the setup options for whether you will have 
the inventory tracking option checked or not. 
If you do intend to track inventory on a job, export the sold job in the inventory tracking mode 
and convert to a sales order or an invoice in QB immediately. If you intend to track inventory 
and want to send an un-sold job to QB, send it in the non-inventory tracking mode. Later, if the 
job is sold, load it again in CFS and export in the inventory tracking mode. 
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Detail of what happens during export/import 
 

When all items in the CFS job are in QB 
When all items on the CFS job are in QB the job will be imported into QB and open in QB 
automatically if QB is open. It is recommended that you have QB open during transfers so you 
can immediately convert sold jobs into sales orders or invoices if necessary. If QB is not open, 
the job will be imported but will not open automatically. 
 

Why would some items not be in QB already? 
 

• QB Premier is limited to 14,500 items and some CFS vendor import modules can 
include tens of thousands of items in one product line. For example Ameristar 
includes 41,000 items. 

• Even though QB Enterprise can contain 100,000 items, most people do not want 
thousands of never sold items in their QB item list. 

• To accommodate for this situation we recommend to initially populating QB with 
only commonly sold items. Uncommonly sold items would get transferred to QB 
only as needed. For example only Ameristar products actually sold would end up 
in the QB item list. There will also be the option to not add uncommon items into 
QB by turning them into write-in entries prior to transfer resulting in the use of a 
catch-all item in QB that can be used over and over again.  

• Letting items populate QB through the export/import process is another way to 
introduce new product offerings into the system. You can put the new items into 
CFS, enter one of each item into the miscellaneous estimator, and export this 
listing to QB. By the time the estimate is created in QB the new products will be 
in the QB item list. Simply delete the newly created QB estimate since you only 
borrowed that process to create it. 

 

Note: When the items are imported to QB they will be on the primary level. You will need 

to make then sub items either manually or by using one of QuickBooks’ mass updating 

tools.  

 

Assemblies (Not applicable if not planning to track inventory.) 
 
Inventory assemblies in QB are equivalent to Assemblies (a.k.a. Additional Pricing Functions) in 
CFS. There are what is referred to as “permanent assemblies” and “reusable assemblies” in QB 
for purposes of this interface. Even though fabrication charges come into play in CFS, they will 
not transfer into the components of assemblies in QB. Regardless, while the cost will be 
different, the selling price in both CFS and QB can be the same if the user prefers them to be 
(recommended). 
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Permanent assemblies 
Permanent inventory assembly items are what you would normally think of. They are items 
fabricated by your business with your purchased raw material. They are setup as Assemblies 
(a.k.a. Additional Pricing Functions) in CFS and may or may not currently be setup in QB. 
 
Assemblies will not be transferred to QB along with the commonly sold items during the initial 
setup. They would either get transferred as needed when an estimate containing one or more is 
transferred to QB or the user can create a CFS Miscellaneous Estimate containing up to 100 
different assemblies per estimate and transfer the estimate to QB. After “borrowing” the export 
feature to populate assembly items into QB it is recommended you delete the estimate in order to 
avoid confusion later. The interface will automatically build each assembly in QB but that is 
okay because the total value of inventory will stay the same and additional assemblies will only 
be built if needed. 
 
If you change the description or components of an assembly in CFS the interface will update the 
assembly in QB automatically the next time it is transferred to QB. 
 
It is important to verify that all the assemblies have a U flag if you want the interface to track the 
component parts used to build that assembly. A “U” flag stands for Un-assemble and instructs 
the program to track the inventory used to build it. Usually an assembly does contain component 
parts you want tracked. But assemblies can also be setup for pricing purposes only. For example 
you could have a record in CFS for the price per 1000 board feet for a certain kind of wood. 
(Maybe that is how your vendor quotes prices to you.) You could have a board setup as an 
assembly with a component part set to the quantity of the per 1000 board foot record. When you 
update the price in the per 1000 board foot record the board price will update automatically. In 
this case, for inventory purposes you want to track the sale of the board, not its component. 
When assemblies are used this way they are not real assemblies of tangible items but it works 
very nice for minimizing the maintenance of product costs. Another example would be if you 
setup all the fabric recordd to have components of records of the price per square foot. You’ll 
want to track the feet of fabric, not the price per square foot. This will work just fine if the record 
does NOT contain a U flag. 
 
A “U” flag is not needed if an “E” flag is in the assembly record. E stands for Explode and 
instructs the program to break out the components to list in the bill of materials. Therefore, these 
assemblies are no longer assemblies by the time they are on the list of materials in the CFS job 
and do not enter the picture by the time the job is exported to QB. This is also why they do not 
need a U flag as they automatically “un-assemble” into the material list when used. 
 

Reusable (Temporary) Assemblies 
 
When fabricated products like fabricated chainlink gates and posts or PVC or ornamental posts, 
rails, pickets, or complete sections are on a job to be exported, the only way to track the 
inventory involved in the production of these parts is to create an assembly in QB. In order to not 
create a permanent assembly for every single different piece that might ever be fabricated as this 
would soon use up all the item spots available to QB, instead, it will treat these fabricated part 
assemblies as reusable. They will not be meant for permanent individual assembly tracking. The 
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assembly will stay intact for a job throughout the life of the sales order. After the job has been 
invoiced then that fabricated assembly item is available to get reused for a new fabricated part 
coming in from CFS. 
 
The names of the reusable assembly items in QB will be the following. 
 
Fabricated Chainlink Scratch Builder gates will be: 
FABRICATED, FABRICATED 1, FABRICATED 2, etc.  
 
Fabricated Chainlink Scratch Builder posts will be: 

FAB-POST, FAB-POST 1, FAB-POST 2 etc. 

 
PVC and ornamental fabricator module fabricated individual post, rails, and pickets will be: 
FAB-PIECE-P, FAB-PIECE-P 1, FAB-PIECE-P 2, etc. or, 

FAB-PIECE-O, FAB-PIECE-O 1, FAB-PIECE-O 2 
 
PVC, ornamental, and wood fabricator module fabricated whole sections will be: 

SECTION-P, SECTION-P 1, SECTION-P 2, etc. or, 

SECTION-O, SECTION-O 1, SECTION-O 2, etc. or, 

SECTION-W, SECTION-W 1, SECTION-W 2, etc. 

  
For example CFS fabricates chainlink gates and posts. Unless you have the chainlink scratch 
builder setup to use pre-built posts on a job it takes the pipe price/foot item times the feet needed 
for the post and adds a cutting charge. For these fabricated posts the pipe item in QB would be 
for a foot – not a stick – and it would be the feet of pipe that is tracked in QB. This is a straight 
forward easy way to track pipe. (There is a way to track sticks of pipe. However, it involves a 
fairly complicated CFS setup process. Please call if you want to discuss this in more detail.) The 
reusable assembly for this post would be named FAB-POST. Each time a fabricated post is 
transferred in a job to QB, the interface would reuse an item named FAB-POST but change the 
description, the component part, and the cost and selling price. If the FAB-POST reusable 
assembly is on a Sales Order in QB the interface will create a new reusable assembly item named 
FAB-POST 1 for the next incoming post. When the Sales Order that includes the item FAB-
POST is invoiced, FAB-POST become available for reuse. This same logic is used for all the 
CFS fabricated products. 
 

Write-in Entries 
CFS allows the user to include an item on an estimate that is not in the Master File (CFS’s item 
list). Items are entered by typing a “W” for (W)rite as the part number. CFS recognizes this as a 
special entry and automatically gives it a part number starting with the word CUSTOM. These 
entries are handled in QB the same way as the CUSTOM parts described in the previous section 
of this manual. If you have some items (but not all your items) in your Master File that you want 
treated as non-inventory temporary items you can put the part number of “CUSTOM” in each of 
those items. You can use a different designation from “CUSTOM” repeated in these items if you 
would like to. Just be sure to have them be non-inventory items. They will be reused each time a 
new estimate comes over with that part name/number. However, in order to minimize how many 
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of these special items are in QB it is recommended you use the designator “CUSTOM” for the 
part name/number of items in CFS you want to be handled by the interface in this special way. 
 

Importance of treating estimates different from sold jobs when 

exporting 
 
A QB assembly needs to be "built" in order for its component parts to be deducted from 
inventory, which is normally a manual task within QB. It is not practical to require the user to 
individually build the assembly for each fabricated part in order to keep the inventory tracking 
updated. So instead, when a job is exported from CFS and imported to QB the fabricated 
assembly will get created and built immediately and automatically. The inventory count of the 
components will get decremented and the inventory count of the assemblies will get incremented 
appropriately. The cost of the assembly is the sum of the cost of the components so the total 
value of inventory will stay the same. When the sales order is converted into an invoice the count 
of the non-assembly items and the count of the assembled items will get deducted from 
inventory.  
 
As you can see, you would not want it to be deducting the raw material that went into the various 
scratch builder fabricated parts if the job is not sold. Thus, if the job is not sold but you want to 
export it to QB anyway, maybe to use some QB functionality, the job needs to be exported in a 
non-inventory tracking mode so it will not build assemblies in QB for fabricated parts or 
permanent assemblies. There is a setting on the export window for either mode. When it is in the 
non-inventory tracking mode the interface uses non-inventory reusable items in QB named 
CUSTOM, CUSTOM 1, CUSTOM 2, etc. If the job is later sold, you need to load it in CFS and 
export it again, this time in the inventory tracking mode. 
 

Note: You can set the inventory tracking/non-tracking default mode in the Program 

Configuration of the Cash Register program or on the Accounting tab in Update Master 

File. 

  
Why do we need to do it this way? CFS is quite sophisticated in its ability to let the user fabricate 
virtually an unlimited variety of products on an as needed basis. There is no way to "mock" this 
ability in QB - QB doesn't have a mechanism for virtually unlimited "what if" fabrication 
scenarios. So basically, you would be "borrowing" the estimate mode in QB for non-sold jobs in 
the non-inventory tracking mode.  
 
The trade off benefit of having to send the job twice is, when you send a sold job in the inventory 
tracking mode you get EXACT, AUTOMATIC, and SMOOTH inventory tracking of all parts 
which includes regular parts, components of permanent assemblies, and the components of the 
potentially unlimited number of products that could be fabricated by CFS. 
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Adequate inventory required to “Build” Assemblies 
(Not applicable if not planning to track inventory.) 
 
If there are any assemblies, permanent or reusable, in a job, there has to be enough component 
parts on-hand in QB to build the assemblies in order for the transfer to take place. If there is not 
enough, a report will pop up about which inventory items are deficient. After receiving an 
adequate amount of these items in QB you can try the transfer again. If you prefer, you can use 
the APF.exe app to export assemblies from CFS and see all the products for permanent 
assemblies that need to be on hand if that assembly is transferred.  
 

Deleting Sales Orders 
 
If a Sales Order contains any assemblies, special considerations should be taken to reverse the 
“build” if necessary. Remember that the component parts are already deducted from inventory. 
This happened when the job was imported from CFS. If the part is already fabricated in the shop 
and you are still going to charge the customer, delete any non-assemblies from the Sales Order if 
you prefer, and convert the remainder into an Invoice. 
 
If you have not actually fabricated the assemblies yet, and are willing to cancel the entire Sales 
Order, you should make an inventory adjustment to reverse the builds either immediately before 
or after you delete the sales order. This is particularly important for the special assemblies for 
items fabricated by CFS as needed for a particular job. See the section in this manual on 
temporary reusable assemblies to identify these assembly items in QB. Reversing the build of 
permanent assemblies is optional as the interface will only build more of them during an export 
if there are not enough on-hand at the time of the export. To reverse a “build” go to “Adjust 

Quantity On Hand” in QB. 

 
The quantity of each of these assemblies should equal the number “On Sales Order” at any given 
time. By reversing the build at the time of deleting a Sales Order you will be keeping these 
amounts correct. If you leave one of these assemblies in stock, but not on a sales order, the 
interface will reuse it by adding to the quantity and averaging the cost in order to keep the total 
value of inventory correct. 



  Page 30 of 35 

Interface Maintenance 
 

Syncing the CFS and QuickBooks item lists 
 

Introduction 
It is important that no one is running CFS when the syncing of inventory counts or prices is 
taking place between CFS and QuickBooks. The only programs that would normally be open 
during these activities are the main menu and Update Master File on the computer where the 
setup or maintenance is taking place. All other users on a network, if you have a network, should 
close out of CFS completely. A reminder will pop up for the person initiating the setup or 
maintenance program. The syncing of the two programs is done in CFS Update Master File. 
After logging in, bring the Accounting tab to the forefront. It should either look exactly like the 
following window or at least include the menu options that appear here. 
 

 
 
 
 
 
The Control Panel is pictured above so not repeated here. The last option, the Tracking Default is 
a toggle switch so double clicking it switches it on or off. The second option for Setup & 
Maintenance is explained below. 
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Setup & Maintenance options: 
 

Transfer items from CFS to QB 
Commonly sold items can be transferred en masse three different ways. Please consult with us 
about these approaches to see which one is the best way for your particular situation and needs. 
Assembly Items should not be exported into QuickBooks with the initial bulk item population of 
the QB item list. (The way assemblies get exported will be explained below.) 
 

1.  If you are not going to use sub-items in QB, AND, you are not going to use sub-
accounts for the Inventory, Cost of Goods Sold, and Income accounts, AND, you 
want almost everything in the CFS master file to import into QB, you can import 
items into QB using the Setup & Maintenance option Export Item List from CFS and 
then Import. Usually you will not want most master file items to import so this tool 
may be more useful for adding just small groups of new items to QB. 

 
2.  If you are not going to use sub-items in QB but you do want sub-accounts, an 

appropriate option is to use the InterOp utility to export the entire master file into a 
spreadsheet program like Microsoft Excel, isolate the items for import into QB into 
sub-groups appropriate for the same QB accounts and save each sheet as a csv file. 
The csvReFormat program needs to be run on this file to reformat it. Then, go to the 
Control Panel and set the appropriate default accounts and go to the Setup & 
Maintenance program and choose Select an Existing List of CFS Items, choose your 
prepared file, and then Import. 

 
3.  If you want to import CFS items into sub-items and sub-accounts in QB you may or 

may not need to use the Setup & Maintenance utility. To import items without our 
utility, you can use the QB import option. Use InterOp to export the entire master file 
into a spreadsheet program like Microsoft Excel and delete all the items that you do 
not want to import into QB. These remaining items need to be formatted into the QB 
required configuration for import directly into QB using the QB import function. 

(a) There is a hybrid of this you may find easier. First export the master file 
(without record numbers) and open in a spreadsheet program. Breakup and 
cull down the items so you have a worksheet for each group of items that 
share the same general ledger accounts. Save each sheet as a csv file. 
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(i) Drag and drop the csv file onto the csvReFormatApp. Or run the app and 
load the csv file. It will rename your original file with an .orig extension 
and put the csv file into a format the Setup & Maintenance program can 
read. 

(ii) On the Setup & Maintenance window choose “Select an Existing list of 
CFS Items”. These will import into the primary level in QB. If you would 
like them to be sub-items, in QB, Item List, Excel menu, choose Export 
All Items. Make a column for the parent item and enter it next to the sub-
items. Back in QB choose Paste from Excel. Paste the parent item names 
into the Subitem of column and Save Changes. Another option is to type 
in the name of the parent item and then right click on it and copy down. 
This will duplicate the name to the bottom of the list. You have more 
control with the first way. 

 
4.  If a new item needs to be added to CFS and QB, after the setup phase, it is 

recommended for smoother operation that the user put the item in CFS first and 

then transfer it to QB as items will not have a way to transfer from QB to CFS. 
(Items can be entered manually in both programs but this is not recommended for its 
lack of efficiency and increased room for error.) To transfer just one or a few items, 
put them in the master file, then go to Misc. Estimator and enter one of each of these 
new items. Then transfer this estimate to QB. You will be prompted to fill in the 
accounts and other necessary info associated with each new item for QB. If you have 
a large number of new items you can still do it this way although you’ll be limited to 
transferring 100 items or less at a time. Or, you can use the same transfer operation 
used during the initial setup to transfer large quantities of new items to QB. 
 

Transfer inventory count from QB to CFS 

1.  You need to Export Item List from CFS before you can access the Import Item 
Inventory Count window. The primary inventory tracking and valuation will take 
place in QB. The purpose of having an option to update the counts in CFS from QB is 
for if you want to use the CFS per job inventory status alert feature and/or the 
suggested order feature. The status alert feature in CFS can be turned on by going to 
Update Master File> Miscellaneous tab> Modify System Settings> in the Misc group 
check Show Inventory Status During Estimating. The place to setup the parameters 
for a suggested product order is on the Inventory tab in Update Master File. 
 

Sync Prices 
You need to Export Item List from CFS before you can access the Sync Price window. First 
choose the appropriate Export button and then the appropriate Update button. 

1.  Export Sales Price From CFS 
(a) CFS contains more sophisticated pricing options than QB, so it will be the 

primary location for the user to establish the retail prices. It is assumed in this 
discussion that the user wants the retail price to be the same in both programs.  

Recommended procedure: use the tools in CFS, Update Master File, and 

Change Pricing Factors to establish your retail selling prices. Then use the 

interface feature to transfer these retail prices from CFS into QB. 
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2.  Transfer average cost or last purchase price from QB to CFS 

(a) This option would be used if you want the cost to be the same in both programs. 
See the following in depth discussion. When you update the costs in CFS you will 
be left in the Update Master File program in CFS. Quit out of Update in order to 
let it recalculate the new retail prices before doing more price syncing in Setup & 
Maintenance. If you now intend to bring that updated CFS retail price into the QB 
selling price make sure you refresh the Export item List from CFS before doing 
so. 

 

Should you transfer cost in QB to cost in CFS 
 
When deciding if you want to transfer either the average cost or last purchase cost from QB into 
CFS let’s first consider why you may NOT want to update CFS with cost amounts from QB. 
 
You can have your replacement cost in CFS so that your Retail Price will be calculated on what 
the product will cost the next time you buy it rather than on what you paid for it in the past. 
QuickBooks would contain the cost based on what you paid for the product in the past as 
required for bookkeeping needs. Regardless of the costs being different in each program, both 
programs can have the same selling price. 
 

 
 
In this example the List Price (Cost) is set to the vendor’s list price with a dealer discount of 8%. 
If a dealer already had a supply of this particular product in the yard and this List Price was 
updated to reflect a price hike that occurred AFTER the last shipment – thus making it the 
replacement list price, the new cost will be the replacement cost and an amount higher than the 
cost previously recorded in QB.  
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As you can see, the Retail Price is calculated based on the Actual Cost plus some optional 
markups plus the margin or markup. This Retail Price can be exported to QuickBooks, which is 
recommended, so the selling price will be the same in both programs. The replacement cost is in 
CFS, the price paid for the product would be in QB, and the selling price would be calculated in 
CFS but exported so it would be the same in QB. 

 

Considerations if you do want to transfer costs from QB to CFS. 
 
When you transfer either the Average cost or the Last Purchase cost from QB to CFS, the 
program will update the List Price (Cost) field in CFS. If some items are setup in CFS to have a 
discount applied to the list price it will be critical that you remove the discount as the cost 
number coming from QB will already be net of discounts. As you can see from the detailed 
pricing structure in CFS, if no discount is entered then List and Actual will be the same amount. 
To remove the discount in CFS go to Update Master File> Change Pricing Factors. If you are not 
familiar with how to use this feature please watch the online video tutorial and/or read about it in 
the manual, or call us for support. 
 
You may only have some items in QB out of the entire product line in CFS that has a discount 
applied to it. So you would not want to end up with the situation where only some of the items in 
CFS have a List net of discount and other that are not. To remedy this, you can decrease the List 
Price by the discount amount. To do this go to Update Master File>Change List Price>choose 
the category or group of items to affect>choose Entering a percentage to add to the List Price 
(Cost). Enter a negative percentage, for example -8 to decrease it by 8%.  
 
You can also use InterOp. You could export the Master File to a spreadsheet program, copy and 
paste special the Actual prices into the List Price field and then import back into CFS. 
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Troubleshooting 
 

(Q) Why does my imported job with CUSTOM part numbers have selling prices different 

from the prices on the job in CFS? 

(A) The CUSTOM parts (CUSTOM, CUSTOM 1, CUSTOM 2, ….~CUSTOM 12) may not 
have been added to the items in QB prior to the job import. This is a setup requirement. If you 
have the situation where there is a discount applied to the job, AND the CUSTOM items are new 
to QB at the time of the import, AND you choose to import the job as a QB Group, the prices 
will not reflect the discount applied to the job in CFS. To correct the current job, first delete the 
estimate from QB. Next make sure the newly imported CUSTOM items are set to be Non-
inventory items and then import the same job again. Now that the items are not new to QB the 
prices should be correct. You should also add the rest of the CUSTOM items through about 
CUSTOM 12 as non-inventory items so that this situation does not occur again. 
 
 

(Q) Communication between CFS and QB is being interrupted. Where do I check path 

information. 

(A) Paths between the two programs are configured in several places. Check the CFSSetup.dat 
file in the local CFS folder and in the server CFS folder if applicable, the path to the QB 
company file, the paths configured in the Control Panel, in the enterprise.xml, and the path used 
when the Interface was installed. 
 
 

(Q) When trying to install QuickBooks I get “Error, Third Party components are not 

found”. 

(A) Go to the website: http://support.quickbooks.intuit.com/support/Articles/INF12417 and 
download your product. Save the file when downloading and then run it to install. 
 

(Q) How do I change the names of multiple items in QuickBooks. 

(A) The ability to do this is in QuickBooks 2010 or later. Use the option in the Item List to 
“Export All Items” on the Excel menu. Make the changes to the item names in Excel but do not 
rearrange the list. Make sure the name field does not include a parent item or the colon that 
separates the parent from the sub item. Back at the Item List Excel menu choose Paste from 
Excel. Copy the new names from the Excel file and paste here. Save. QuickBooks provide 
several methods for editing and adding the item list. See the QB tutorials and directions for more 
information. 
 


